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What Is ClipCache Plus?
ClipCache is an easy to use and powerful clipboard extender. Whenever you use the standard Windows 
clipboard to cut and paste, only one item may be placed onto the clipboard at a time. Thus, copying an 
object to the clipboard deletes the clipboard’s previous content. However, with ClipCache installed it 
quietly sits in the system, monitoring the clipboard. ClipCache automatically saves clipboard objects to the
currently active group. Clips may then be retrieved minutes, hours or weeks later.

Unlike many other clipboard extenders ClipCache adopts a standard Windows look and feel (drag and 
drop, property pages, context menus for both group and item panes) and is highly intuitive. ClipCache has
been designed for both mouse and keyboard users.

The ClipCache main window is divided up into three separate areas (panes.)

· Group pane
· Item pane
· Preview pane

Help
To help for a specific menu item, highlight the menu item and press F1.

Clipboard Formats
Currently the only clipboard formats supported are:

Text: Plain text
Rich Text: Text with formatting (font/size/colour) attributes
OEMText Text displayed in an OEM font
Bitmap Device independent bitmaps
Enhanced Metafile Graphics (I.E. clipart)
Drop File: Saves the names of files when ‘Copying’ or ‘Cutting’ a 

file in explorer

Future versions will support more formats.



Shareware Notice

ClipCache is shareware. You are granted free use of this program for 30 days for evaluation/trial 
purposes. Use beyond this period requires payment for the product. If you find this program useful please 
consider purchasing.

When you purchase ClipCache it entitles you to support and free updates with enhanced features. Failure
to purchase after the trial period will result in extremely limited functionality.

Purchasing online
To purchase online use the Purchase ClipCache Now command in the Help pulldown menu (note, you 
will not see this command if you have previously purchased ClipCache.)



Groups
Clipped items belong to groups. Groups help you to categorise and structure your clips. For example, you
may have groups for URLs, signatures, programming, research topics etc…

Each group has its own set of properties. For example restricting the size of the group to 100 items or 
maintaining the size of the group at 200Kb.

ClipCache maintains a special group called 'Trash' in which it keeps all deleted items until you decide to 
empty the trash. Items deleted from the trash group are permanently deleted.

If a group is active, this will be the group that will receive new clips when you copy from within an 
application. You may organise items within groups by dragging and dropping items between groups. Even
drag text from your text editor directly onto the group.

Sorting and Ordering
Groups can be arranged in any order. This is done by dragging and dropping the selected group to a new 
position. Each group remembers the sort criteria used for the item pane. For example you may wish to 
have a “New Clips” group sorted by date, and a “Trash” group sorted by size.

Drag and drop
Any supported clipboard object may be dragged from an application (which must support drag and drop) 
to any group. 



Items
The items pane enables you to view the contents of each group. Choose to view items as large icons, 
small icons, list or as a report. In report view each clip item displays its name (which may be modified), 
the size and the date that it was clipped.

Drag and drop
Items may be dragged and dropped to and from ClipCache For example, drag a previously captured 
Enhanced Metafile (clipart) from ClipCache to Microsoft Word. It is also possible to select multiple items 
and drag those to the destination application – plain text clips will be automatically merged.

Any supported clipboard object may be dragged from an application (which must support drag and drop) 
to the item pane.

Column Sorting 
Click on a column header to sort the list by Name, Size, Format, Date (default) or Source. Clicking on a 
column header that is currently sorted will reverse the sort order between ascending and descending. An 
arrow in the column header will indicate the currently sorted column and the order. Each group 
remembers the sort criteria used for the item pane. For example you may wish to have a “New Clips” 
group sorted by date, and a “Trash” group sorted by size.

Sorting is also available by right clicking the column header of the column you want to sort on; this brings 
up a menu where you can choose the sort order.

The order of the columns can be changed. This is done by clicking on the column header and dragging it 
to a new position.



Preview
The preview pane shows you the contents of the currently selected item in the item pane. The font used 
to display text clips is configurable. The preview pane may be toggled between normal and maximized 
view using the View|Maximize Preview Pane command.



Running ClipCache

First Time Use
It is recommended to have ClipCache automatically load when you start a Windows session. When 
ClipCache is running you will see a ClipCache icon in the system tray (located at the end of the task-bar.) 
Load ClipCache if it is not already running. Note: you may only have one instance of ClipCache running at
any one time.

The first time you run ClipCache it will be configured ideally for the first time user. For example, it 
starts up with the main window open. As you become familiar with ClipCache you will most 
definitely want to change the default options. 

If you have not already done so, create a new file in which ClipCache can store the captured clips:

· Select New Database from the File menu to create the file.

Using Groups
When a ClipCache file has been created you will be presented with two groups.    A ‘trash’ group and a 
‘new clips’ group. The arrow to the left of the group denotes the active group. As ClipCache monitors the 
clipboard activity it will add the clipboard object to the active group. Note, if you do not have the active 
group selected, you will not see the newly added item.

Each group has a set of configurable properties. To view the properties:

· Select the group and choose Tools | Properties (you may also use the right-click menu or the 
keyboard shortcut Alt+ENTER.)

Using Items
To put an item onto the clipboard, select it and the choose Edit | Copy (you may also use the right-click 
menu or double-click the item [if enabled in options.])

For access to frequently used clips it’s a good idea to assign a shortcut key to the clip. This can be done 
from the item properties.

To organise your items into groups, Items may be dragged from one group to another. Items may also be 
dragged to other applications, such as WordPad. Each item has its own    properties. Select the item and 
choose Tools | Properties (you may also use the right-click menu or the keyboard shortcut Alt+ENTER.)

See also: How To Organise Items

Hotkeys
To get the most out of ClipCache you should configure hotkeys -- see the options dialog box.



Item Properties: General

Details 
Displays the clip’s name, format, size and date that the clip was captured. The Source window 
indicates the window title that the clip was copied from. The Source URL indicates the (web page) URL 
where the clip was captured - the source URL is usually only applicable when copying data from a web 
page.

Shortcut key
A system wide shortcut key may be assigned to this clip. This will cause the item to be copied to the 
clipboard (and optionally pasted into the program you are working in) whenever the shortcut key is 
pressed. To setup a shortcut key, click in the shortcut key box and press the desired keys, the box will 
update with the names of the keys you wish to use. If the key is already assigned to another clip, then 
“None” will appear in the box and you will have to try a different combination of keys. Shortcut keys can 
also be managed and maintained by choosing View|ClipShortcutKeys.

Shortcut action
This determines what action should be performed when the shortcut key is pressed. The default action is 
Paste clip into program and is the recommended setting. A description of each action is described 
below:

§ Copy the clip to the clipboard only 
When the shortcut key is pressed, the associated clip will be copied to the clipboard but not pasted.

§ Paste clip into program (recommended setting)
When the shortcut key is pressed, the associated clip will be copied to the clipboard and pasted it into
the program you are working in. The clip will be pasted using the best method by checking the 
program against the paste keys window list.

The following actions are for advanced use, you generally will not need to use these:

§ Paste clip into program (invokes Shift+Insert)
When the shortcut key is pressed, the associated clip will be copied to the clipboard and pasted it into
the program you are working in. It will always use Shift+Insert to paste the clip, and will not use the 
paste keys window list list to determine how the clip should be pasted

§ Paste clip into program (invokes Ctrl+V) 
When the shortcut key is pressed, the associated clip will be copied to the clipboard and pasted it into
the program you are working in. It will always use Ctrl+V to paste the clip, and will not use the paste 
keys window list list to determine how the clip should be pasted



Group Properties: General

Displays the group’s name, type, size and number of items it contains.



Group Properties: Purge

The purging of groups allows easy maintenance of the database size. Purge settings are configurable for 
each group. When you choose Purge All Groups or Purge Group  these settings will be used in the purge 
operation.
 
Limit the number of items stored in this group:
Keeps the group’s item count at the value specified by moving older items to trash. This option may be 
toggled on or off whilst maintaining the chosen value.

Limit the size of this group:
Keeps the group’s storage size at the value specified (expressed in bytes, Kbytes or Mbytes) by moving 
older items to trash. This option may be toggled on or off whilst maintaining the chosen value.



Options: General

Double click action
What action should be taken when double clicking on a item, in the item pane.

Double clicking (or enter) on an item copies to the clipboard:
If enabled, double clicking an item will copy it to the clipboard. This offers an alternative way to place 
items onto the clipboard besides using the EditCopy command.

and pastes into the last used application:
If enabled, when you double click on a clip it will be immediately pasted into the most recently used 
application (as indicated by ClipCache’s title bar.) This option can only be enabled if you have enabled 
‘Double clicking on an item copies to the clipboard.’

ClipMenu
ClipMenu configuration. 

ClipMenu pastes the chosen clip into the last used application:
If enabled, when you select a clip from the ClipMenu, it will be immediately pasted into the most recently 
used application.

Show the ClipMenu in the system tray menu:
When right clicking on the ClipCache tray icon, a menu will appear. If this option is enabled, the ClipMenu 
is appended onto the tray icon menu. Usually the ClipMenu is accessed via a Hotkey. However, some 
users may prefer to use the tray icon in favour of a hotkey.

Show a maximum of N clips in each ClipMenu popup group:
Each group is shown as a submenu off the main ClipMenu. N specifies the number of clips to be shown in
each ClipMenu submenu.

Show a maximum of N ClipMenu popup groups:
N specifies the number of groups (submenus) to show in the ClipMenu. 

Other
Other general options.

Update names of text clips after editing in the preview pane:
If enabled, whenever you make edit in the preview pane, the name of the clip will be updated to reflect the
changes made in the preview pane.

Move an item to the top of the list on copying to clipboard:
If enabled, when copying a captured item to the clipboard, the item is moved to the top of the list and its 
date attribute is updated to the current date. Selecting this option has the effect of moving all the most 
recently used clips to the top of the list, so they can be easily accessed.

Play this sound when capturing:
If enabled, whenever ClipCache captures a clip, a wave sound will be played. You may enter the filename
of a wave file in the box below. Chose the ‘Browse…’ button to help locate the wave file. If you do not 
specify a filename or it does not exist, a system default sound will be played (if configured in your 
operating system.)



Options: Window

Minimizing
ClipCache’s main window minimizing options.
 
Minimize after copying a clipped item:
If enabled, after you click copy from within ClipCache, the main window will be minimized.

Minimize after drag & dropping to an application:
If enabled, after you drag an item from ClipCache to an external application, ClipCache’s main window 
will be minimized.

Minimize when switching away:
If enabled, when ClipCache loses input focus, for example when you switch to a different application, 
ClipCache’s main window will be minimized.

After minimizing ClipCache remains visible in the task bar:
If enabled, ClipCache is always displayed in Window’s task-bar. This enables Alt-Tab to be used to 
access ClipCache. Useful for those users that prefer Alt-Tab instead of using a Hotkey to show the 
window.

Visuals
Appearance options. 

Window always on top:
If enabled, ClipCache’s main window will always be on top of all other windows.

Show the Quick Paste target in ClipCache’s title bar:
If enabled, the QuickPaste target will be displayed in ClipCache’s title bar.

When selecting a group, re-select the last selected clip:
If enabled ClipCache remembers the last selected clip in a group. When you re-select the group the last 
selected item will be selected by default. 

Show grid lines in the item pane:
If enabled, grid lines are displayed in the item pane.

Use full row selection in the item pane:
If enabled, clips may be selected by clicking any column of a clip. Also, the highlighted bar for the 
selected item spans all columns. 

Close Button

Closing the window exits ClipCache:
If enabled, the ‘X’ button in ClipCache’s title bar will exit ClipCache rather than just minimize the window.



Options: Hotkey

Show ClipCache’s main window:
Set this system wide hotkey to bring ClipCache’s main window to the top. You may press ESCAPE to 
dismiss the window without taking any action. Or you may choose to copy an item by using the mouse or 
keyboard.

ClipMenu:
Set this system wide hotkey to invoke ClipMenu.

QuickSelect
Setup quick select hotkeys. See How To Use Quick Select and QuickSelect.

QuickSelected up:
This system wide hotkey places the item just above the currently selected clip onto the clipboard. 

QuickSelect down:
This system wide hotkey places the item just below the currently selected clip, onto the clipboard. 



Options: Startup

When ClipCache start
Operations to be carried out when ClipCache starts.

Automatically open the most recently used ClipCache file:
If enabled, when ClipCache loads, it will re-load the latest ClipCache file that you were working with.

Start with ‘Capture Clips’ set to enabled:
If enabled, clips will be captured immediately after ClipCache has loaded.

Start with the window hidden:
If enabled, the ClipCache main window will initially be shown as a hidden window. You will still be made 
aware of the presence of ClipCache by the system tray icon.

When opening a ClipCache file
Operations to be carried out when a ClipCache files is opened.

Copy the clip selected clip to the clipboard:
If enabled, the selected clip in the item pane will be copied to the clipboard. This allows you to restore the 
contents of your clipboard between sessions, without having to manually copy the clip. 

Purge all groups after opening a ClipCache file:
If enabled, ClipCache will purge all the groups when opening a ClipCache file. Setting this option and 
setting up reasonable purge options will help maintain the size of your ClipCache groups.

Clear ‘Trash’ after opening a ClipCache file:
If enabled, the contents of the trash group will be deleted (permanently.)

Compact the clip storage when opening a ClipCache file:
If enabled, the ClipCache files will be automatically compacted.



Options: Advanced

Autosave
Customise auto saving intervals.

Automatically save the database every N minutes
Captured clips are immediately added to the ClipCache data file (.DAT), however, the index (.IDX) file’s 
content is held in working memory. The index file is updated when the user exits ClipCache, or when 
manually choosing File | Save. On the event of a system crash, all your clips would be lost the next time 
ClipCache starts, because it wasn’t able to save the index file. This option allows you to specify how often
the index file should be automatically saved – offering peace of mind.

Confirmations
Enable or disable confirmations dialog boxes.

Capture
Customise what clipboard objects to capture.

Capture delay:
When copying to the clipboard, ClipCache waits for the duration specified here before capturing the data. 
This gives applications time to “cool down” after it places data on the clipboard.

Try to avoid capturing duplicate clips:
If enabled, captured clips are compared against existing clips within the active group. If found, the current 
clipboard object is ignored and the (older) duplicate is moved to the top of the list – its date attribute is 
adjusted to reflect the current date and time.

Shift+Insert pasting
When ClipCache performs a QuickPaste or FormPaste it performs a paste operation in the program you 
are working in. A small number of programs do not use Ctrl+V for pasting, and instead they use 
Shift+Insert. For these programs, QuickPaste and FormPaste will not function correctly unless you tell 
ClipCache about the program. This option will allow you to customize which programs use Shift+Insert 
keys for pasting.



Options: Confirmations

Enable or disable confirmations dialog boxes, for example when emptying trash you may not want to have
that action confirmed.



Options: Capture Options

Capture Enhanced Metafiles:
Recommended setting is disabled! If enabled, captures Enhanced Metafiles. These can be quite large so 
default is disabled.

Capture OEMText:
Recommended setting is disabled! If enabled, captures OEMText as well as regular Text.

Capture Rich Text Format (RTF):
If enabled, captures Rich Text, this allows text formatting attributes (font/size/colour) to be captured from 
supporting application such as MS Word.

When Rich Text is available ignore plain text:
If enabled, Rich Text will be captured (when available) instead of plain text. This will avoid duplicate 
captures, one in plain text and one in Rich Text.

Maximum size (in bytes) of plain text captures:
If enabled, text clips exceeding N bytes will not be captured. Useful if you are copying/pasting large 
amounts of text and you do not wish to waste disk space.

Maximum size (in bytes) of Bitmap captures:
If enabled, bitmap clips exceeding N bytes will not be captured. Useful if you are copying/pasting large 
images and you do not wish to waste disk space.

Maximum size (in bytes) of Rich Text captures:
If enabled, RTF clips exceeding N bytes will not be captured. Useful if you are copying/pasting large 
amounts of text or images and you do not wish to waste disk space.



Options: Paste Keys Window List

When ClipCache performs a QuickPaste or FormPaste it performs a paste operation in the program you 
are working in. A small number of programs do not use Ctrl+V for pasting, and instead they use 
Shift+Insert. For these programs, QuickPaste and FormPaste will not function correctly unless you tell 
ClipCache about the program. This option will allow you to customize which programs use Shift+Insert 
keys for pasting.

For example, if you use a telnet program that uses Shift+Insert keys for pasting, and the title bar text for 
its window is “My Telnet Program”. You would add “telnet program” to the window list; you can use partial 
text – you don’t have to specify the entire text. When QuickPaste is next used in this window, Shift+Insert 
will be used to paste the text.
 



Plug-ins

Plug-ins allow you to extend ClipCache in a way that best fits your needs. Plug-ins are packaged in a DLL
(dynamic link library) file and they live in a “plugins” folder just below where you have installed ClipCache.
For example “C:\Program Files\ClipCache\Plugins”.

Properties
Some plug-ins may have a properties dialog (some may not). Clicking the Properties button will show a 
properties dialog for the selected plug-in.
 
Details
The details button will reveal the location of the plug-in DLL file, and any other additional information.

Online Plug-ins
Launches you default browser and tries to connect to the plug-ins website. Here you may find new or 
improved plug-ins to download.

Installing and Uninstalling Plug-ins
To install a plug-in you can simply copy the DLL to the “plugins” folder. You will then have to restart 
ClipCache. To uninstall a plug-in you must exit ClipCache first and then delete the DLL file. If the plug-in 
comes with it’s own installation instructions, then you should follow those. For example, some plug-ins 
may come with their own setup program.



Active Group

The active group is the group that receives all captured clips. There can only be one active group at any 
time. An arrow to the left of the group icon indicates the active group.

There are three ways you can activate a group:

· Left-click in the space to the left of the group
· Right-click on the group and choose Activate Group
· Select the group, then choose Tools | Activate Group



QuickPaste

“QuickPaste” pastes the item(s) selected in the item pane into the most recently used application. It 
automates the following processes:

· Copy the selected item(s) to the clipboard.
· Switch to the most recently used application.
· Paste into the most recently used application.

For example, open the Microsoft Windows Notepad, then open ClipCache’s window, select a text clip and
then click the ‘Quick Paste’ toolbar button. The text will be pasted immediately into Notepad.

QuickPaste may optionally be set as the default behaviour when double clicking on an item, or when clips
are selected from ClipMenu.



QuickSelect

QuickSelect is only available via hotkey access. There are two hotkeys that should be set up, one for 
QuickSelect Up and one for QuickSelect Down. The up and down direction have special meaning:

· QuickSelect Up: The clip above the currently selected clip should be copied to the clipboard.
· QuickSelect Down: The clip below the currently selected clip should be copied to the clipboard.

The main window does not need to be open. A tool-tip will temporarily appear just below the mouse 
pointer showing details such as the name of current clip.

Press Ctrl+V to paste into the application you are working in. Alternatively you can click on the tool-tip 
with the mouse to paste the clip into the application you are working in.



AutoPaste

What is AutoPaste:
When AutoPaste is enabled, anything that you copy to the clipboard will be captured by ClipCache and 
automatically pasted into the designated AutoPaste target window. You can set target to be any 
application that you can paste into.

An example of how to use AutoPaste:
Open a text editor (Notepad will be used in this example), then open ClipCache’s main window. The 
QuickPaste target will be, Notepad, as identified by the title bar in ClipCache. Then Click “Edit | Auto 
Paste | Enable AutoPaste.” This sets the AutoPaste target to be the same as the QuickPaste target 
(Notepad). Now you may minimise ClipCache, if you wish. Finally, copy some text from any application 
and see it AutoPasted into Notepad.

Input focus is temporarily switched to Notepad, and returns back to the window you are working in. This 
can be turned off (AutoPaste | Target Keeps Focus) allowing you to capture text, make extra edits in 
Notepad, you can then manually return back to the application you were working in.



ClipMenu

The ClipMenu is a popup menu that appears right in the application you are currently working in. The 
menu containing clips as menu-items, and groups as submenus. Choosing a clip will copy it to the 
clipboard and optionally paste it into the application you are currently working in.

The ClipMenu is invoked by assigning it to a hotkey or by setting an option to include it as part of the tray 
menu. When the ClipMenu appears there are 4 ways use the menu:

· Use the mouse to navigate the menu and click on a clip.
· Click anywhere outside of the menu to dismiss it.
· Use the cursor keys to navigate the menu and hit enter on a clip.
· Press ESCAPE to dismiss the menu without taking any action.

For the chosen clip to be pasted clip into the application you are working in, you should ensure that 
QuickPaste is enabled in the ClipMenu section is enabled.



Clip Shortcut Keys
The shortcut key window provides a centralised environment for management of shortcut key 
assigned/associated clips. Shortcut keys are not assigned to clips in this window; this window 
provides maintenance only.

To assign a clip to a shortcut key: in ClipCache’s main window right-click on the clip and choose 
Proprties. In the properties dialog that appears setup the shortcut key and press OK. The clip will then 
appear in the shortcut key window.

Columns

Hotkey Indicates the key-press required to activate the shortcut
Name The name of the clip assigned to the shortcut
Group Displays the group name that the clip belongs to
Action Indicates the method used to paste the clip when the shortcut 

key is pressed

Commands

Properties Shows the clip’s properties
Locate Clip Highlights the clip in ClipCache’s main window
Unassign Removes the associated shortcut key from the clip
Unassign All Removes the associated shortcut key for all clips
Close Closes the shortcut key window



Credits

Author: John Williams
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Version History

2.9

New:
· Added new command, File|ArchiveDatabaseAs that will save the database as a copy. Useful for 

backing up your database.
· Advanced options have been improved to allow programs to be specified that use Shift+Insert for 

pasting. A new dialog box helps organize and maintain a list of these programs. For example, telnet 
programs use Shift+Insert for pasting, you would add this window to the list so QuickPaste, 
FormPaste and AutoPaste paste correctly.

· Clips that have shortcut keys assigned to them are also aware of the Shift+Insert window list by 
default.

· Clip properties have been extended to cater for the new Shift+Insert window list.
· View|KeepWindowOpen has been improved; it now ensures the main window always on top during 

the time when KeepWindowOpen is enabled.
· The context (right-click) menu can now be displayed by pressing Shift+10 from the keyboard. 

Shift+F10 is the standard combination for the context menu. The menu will appear next to the current 
selection.

· Where a column’s text appears truncated/ellipsis (…) tooltips now appear with the full text.
· Increased the number of ClipMenu groups shown to a max of 50, and a max of 50 items in each 

popup.
· If the taskbar’s process (explorer.exe) exits and is subsequently restarted, ClipCache now re-adds its 

tray-icon automatically.
· Included the Import plugin in the archive. The Import plugin imports files (bitmap and text) as clips.
· Included the ROT13 plugin in the archive. ROT-13 provides simple encryption/decryption of text.

Changes:
· The main window now restores its maximized state between sessions. Previously if the window was 

maximized and ClipCache was restarted, the window would always default to restoring to the normal 
position.

· Renamed menu item File|SendClipByMail to File|MailClip.
· Other minor GUI changes.

Fixes:
· Fixed a bug where File|SaveAs would sometimes not save the database under a different name.
· Fixed a memory leak.
· Fixed a bug in QuickSelect that could sometimes cause an exception – rare but possible.

2.7

New:
· ClipCache now supports plug-ins to allow you to extend ClipCache to fit your own needs. A new 

“Plug-ins” menu has been added.
· Added plug-in: “Word Count”, counts the number of words, characters (with and without spaces) and 

paragraphs in the clip.
· Added plug-in: “Extract URLs”, extracts all URLs embedded within a clip, URLs may be collated into 

one clip or extracted to individual clips.
· Added plug-in: “Rules”, allows actions to be triggered based on the criteria of a clip. An example rule 

would be to move all clips containing “http:” to the “URLs” group.
· Added plug-in: “Capture Counter”, simply keeps a count of the various formats that have been copied.

This is useful to track how often you use ClipCache.
· Confirmation dialogs for “deleting a clip from trash”, “emptying trash”, “purging a group” and “purging 

all groups” can be toggled on/off in Tools|Options|Advanced|Confirmations



· Added a new “Source URL” column to the item pane. This represents the URL where the clip was 
copied.

· Added "Go to Source URL" to the item pane right click menu, allowing the web page to be loaded 
where the clip was captured from.

· Added command “Keep Window Open” to the View menu and the toolbar to temporarily override any 
auto-minimization options such as minimize when switching away.

· Text cleanup operations are now available from an improved Text Cleanup toolbar dropdown button.
· Edit|Find (and FindNext) has been improved; it now highlights any matching text and scrolls it into 

view.
· Edit|Find dialog now allows the “Source Window” and “Source URL” fields to be specified in the 

search.
· You can by find the next occurrence of a search string contained in a clip by clicking Edit|

FindNextInClip or pressing F4.
· Added a new text cleanup operation, "MIME encoding" which converts %hex (or =hex) to its ASCII 

equivalent.
· Item properties dialog now allows fields to be modified : Name, Source Window and Source URL are 

all editable.
· URLs in the preview pane are auto detected and can now be double-clicked on to launch the default 

browser. 
· Left clicking in the space to the left of the group name now changes the “active group”. This allows 

the active group to be changed without the need to select the group.
· Text word wrap is now remembered between sessions.
· Added “ClipCache Starts When Windows Starts” to Startup options.
· Added a startup delay in Startup options. So, if ClipCache starts when Windows starts, you can now 

specify a delay to allow other applications to start first.
· ClipCache options are saved out on a per user basis, so each person that logs onto Windows can 

have their own set of options; instead of all options being system wide.
· Added accelerator SHIFT+ENTER to Edit|QuickPaste menu item. Pressing SHIFT+ENTER will paste 

the clip to the last used program.
· Holding down SHIFT when double-clicking a clip will QuickPaste the clip to the last used program. 

Note: double-click action must be enabled in Tools|Options|General.
· Holding down SHIFT+CONTROL when double-clicking a clip will FormPaste the clip to the last used 

program. Note: double-click action must be enabled in Tools|Options|General.
· The hotkey for the main window minimizes the window if it’s already active.
· Added Tip Of The Day to the Help menu.
· The first time ClipCache is run, you are now prompted to create a database. The default behaviour 

was to create the database in ClipCache's installation folder.
· FormPaste automatically moves to the next clip in the item pane.
· FormPaste toolbar button has been improved to allow multiple form pastes to be processed in one-

click.
· Right-click drag-drop (with popup menu) is now supported, instead of only left-click drag-drop.

Changes:
· Capture settings now have their own dialog, accessible via the Advanced options tab.
· Moved option "Update names of clips after editing" from Window to General options tab.
· ClipCache should no longer be required in the start menu; it now uses the registry to run when you 

start windows.
· The database format has changed; the new format is not compatible with older versions of ClipCache.

Databases will automatically be converted to the new format without data loss.
· Double-clicking a group no longer sets the groups as active.
· “Remove Linebreaks” (text cleanup) now keeps paragraphs 1 empty line apart.
· When copying from groups that have their clips sorted “by Position”, the clip it not moved to the top of 

the list when “Move clip to top of list on copy” is enabled in options. 
· ClipCache uses the registry to store all program options.
· Minor changes to the capture code.



· Renamed menu item Terminate in the File menu to Exit.
· Clip hotkeys are now called Shortcut-keys. The clip’s properties and other dialogs have been updated

to reflect this.
· View|ShortcutKeys accelerator has now been moved to Ctrl+K.

Fixes:
· Fixed a bug the prevented the database from automatically loading at startup.
· Preview pane word wrap would always default to “wrap enabled” when selecting a clip. It now 

remembers the word wrap setting correctly.
· When clicking Options in the tray menu, ClipCache’s main window used to open. It now stays 

minimised.
· ClipCache used to complain if you tried to open a database that was read-only. Read-only database 

files can now be read, for example to allow a database to be shared over a network.

2.6

New:
· Added command “by Position” (View->Sort menu) to support manual sorting of clips.
· Item pane clips can be arranged in any order by dragging and dropping (requires sort by position to 

be enabled)
· Groups can be arranged in any order by dragging and dropping.
· Each group remembers the sort criteria used in the item pane. I.E. it is possible to have “New Clips” 

group sorted by date and “Trash” group sorted by size.
· Added command “Maximize Preview Pane” (View menu) - also on the toolbar - that toggles the 

preview pane size between normal and maximized.
· Added command “Page Setup” (File menu) to allow the page margins to be set for printing.
· Added support for immediate pasting of clips when an item hotkey is pressed. Three methods of 

pasting: Copy only, Ctrl+V and Shift+Insert.
· Added command “HotKeys” (View menu) that brings up a new window allowing maintenance of all 

clip hotkeys in one central place.
· Added formatting operations:

· Text -> Lines -> Paragraph Spacing
· Text -> Case -> Transpose
· Text -> Case -> Sentence
· Text -> Case -> Sentence Strict
· Text -> Case -> Word
· Text -> Case -> Word Strict

· Added command “Convert To Plain Text” (Text menu.)
· Added option (general tab) “Update names of text clips after editing in the preview pane.”
· Added a “Reverse” order button to the Merge dialog.
· Added a “Delete merged clips” option to the Merge dialog.
· Added “Print” toolbar button.
· Added “Print” and “Cleanup Text” to the item pane right-click menu.
· Added “Sort by Name” to the group pane right-click menu.

Changes:
· The database format has changed; the new format is not compatible with older versions of ClipCache.

Databases will automatically be converted to the new format without data loss.
· The command “View HotKey Items Only” (View menu) has been replaced by a more powerful 

command “HotKeys” (View menu). 
· If Autoload fails it now prompts for an alternate file to be loaded.

Fixes:
· Fixed a memory leak.



· Fixed a bug where “Save As…” (File menu) would save the files correctly, but appended captures to 
the original datafile instead of the new “saved as” file.

· Fixed a bug where the use of the File menu “most recently used” entries did not correctly handle 
attempting to load a nonexistent file.

· Fixed a bug where merging text from a group that is not active meant the item pane had to be 
refreshed for the clip to be visible.

2.5

New:
· Rich Text clipboard format support (font size, type, colour, etc. attributes are retained.)
· Added a “Print” command (prints all formats.)
· Added preview pane word-wrapping toggle.
· Added preview pane in-place editing.
· Added preview pane context menu.
· Added preview pane “Find and Replace” dialog.
· Clips can be sent by email (including images as attachments) through MAPI.
· Added a new feature: ClipMenu. When invoked by a hotkey, displays a popup menu of clips right in 

the application you are working in. Groups appear as submenus on the popup, this makes accessing 
and pasting clips even more flexible and quicker.

· The ClipMenu can be included on the system tray menu to allow access of multiple groups via 
submenus.

· Added more text formatting operations:
· Trim '>' indentation (ideal for heavily quoted email/newsgroup text)
· Trim '|' indentation
· Trim ':' indentation
· Trim Space indentation
· Trim Tab indentation
· Strip < > from email addresses.
· Strip 'HTML tags'

· Added a “Cleanup Text” dialog allowing all formatting operations to be simultaneous processed 
(settings can be saved as pre-sets for later use.)

· Added “AutoPaste” which when enabled, will automatically paste whatever you copy into a chosen 
target window.

· The Find and Replace dialog now supports finding and replacing "special characters" (ie: newline, 
tab, linefeed, etc.)

· The Find Clip dialog now supports finding "special characters" (ie: newline, tab, linefeed, etc) within 
the content of a clip.

· The Merge dialog now allows you to specify text between clips when merging, including special 
characters.

· The QuickSelect tool-tip has been improved:
· The tip displays current clip number out of the total number of clips.
· Clicking on the tool-tip will paste the clip into the active application.
· The Item pane column headers can now be positioned in any order (from left to right) by clicking on 

the column header and dragging to a new position.
· Added support for saving Rich Text clips as a separate file.
· Added accelerator Ctrl+M to Text|Merge Text Clips.
· Added capture options (advanced tab) to support Rich Text.

Changes:
· "View | Set Font" menu command has been moved into the Text menu.
· Preview pane editing means the editor dialog is no longer necessary.
· Copy and Pasting while renaming a clip now works much more intuitively
· The Options|General page has been modified to incorporate new ClipMenu features



· Performance and user-interface enhancements.
· Improved the clip capture code.

Fixes:
· Small bug fixes.

2.19a

Changes:
· On start-up the group column width defaults to the previous group splitter window width. If this was 

zero width, the groups would appear invisible (zero width) even when expanding the splitter – now 
defaults to a reasonable width if this is the case.

Fixes:
· Fixed a bug that prevented images from being pasted into various apps.
· Fixed "The picture is too large and will be truncated" warning.

2.19

New:
· Added new feature "FormPaste" which pastes the selected clip into the most recently used 

application and then TABs to the next field.
· Added a Hotkey page to options dialog.
· Added command Tools|RepairClipboardChain, re-establishes a connection to the clipboard.
· Added command View|AlwaysOnTop (Ctrl+T), makes ClipCache's window the topmost.
· Added command Tools|PurgeGroup to allow purging of just one group.
· Added option “When selecting a group, re-select the last selected clip “ to the window options page.
· Added option "show gridlines in item pane" to the window options page.
· Added option "full row select in item pane" to the window options page.
· Added option "Capture Delay" to the advanced options page.
· Added "Source" column to the item pane.
· Added context menu for item pane column header.
· Added menu: View|Sort

· Ascending Order
· byName
· bySize
· byFormat
· byDate
· bySource

· Added accelerator Ctrl+I for Tools|Options

Changes:
· Re-organised context menus.
· Removed accelerator Ctrl+N from File|New.
· Changed accelerator for CreateNewTextClip from Ctrl+T to Ctrl+N.
· Changed Tools|CaptureClips accelerator from Ctrl+U to Ctrl+R.
· The command Edit|Paste in ClipCache now pastes to the selected group (not the active group). 

Copying from an application still captures to the active group however.
· If autoload disabled, user is alerted to create a data file.
· Cutting/Pasting from within ClipCache now keeps each individual clip intact (rather than merging). 

The merged result is also kept on the clipboard for pasting into other apps.



Fixes:
· Fixed a bug that caused the QuickSelect tooltip to grab focus, thus preventing pasting into the 

application you are working in until the tip was destroyed.
· Fixed Text|RemoveLinebreaks which was eating 2 CRLFs and not keeping paragraphs separate.
· Fixed a bug that caused a crash if IDX/DAT files were missing
· Minor fixes

2.12

New:
· Added Tools|CaptureClips accelerator Ctrl+U.

Changes:
· Improved the capturing process.

Fixes:
· If “Copy clip at the top of the list to the clipboard” in Tools|Options|Startup was enabled, the first 

capture would be ignored.
· Disk space was not being correctly reclaimed after editing clips.

2.11

New:
· Added an option to copy the clip at the top of the list to the clipboard, on startup.
· Added command Next Pane & Previous Pane to the View menu (shortcut Tab & Shift+Tab.) 
· Added command Help Pointer to the Help menu (shortcut Shift+F1.)

Changes:
· The Item pane receives input focus on startup, instead of the Group pane.
· The tray menu reflects the selected group (including sort order), instead of the active group.
· Bitmaps that exceed the capture limit are rejected much earlier (prior to any processing.)
· Two new commands Next Pane and Previous Pane replace ‘Switch Pane’ in the view menu.

Fixes:
· Quick paste target failure when window on top is disabled - fixed.
· Bitmaps were not correctly captured from specific apps - fixed.

2.10

Features:
· Added a Quick Paste feature to enable immediate pasting into the most recently active application.
· Added a "Quick Paste" toolbar button.
· Added an option to display the Quick Paste target in ClipCache’s main window title.
· Added an option to use Quick paste when double-clicking an item.
· Added an option to use Quick Paste with the system tray.
· Added an option "Minimize when switching away."
· Added a "Window" tab to the Options dialog.
· Restructured the Options dialog.
· Added a delete button to the Merge dialog.
· Improved the Merge dialog GUI.
· ClipCache "not capturing" tray no-entry icon has been removed in favour of a cross.
· If no datafile is loaded a warning message is displayed in the item pane.



· Minor GUI improvments.

Fixes:
· Some users report repainting problems when resizing the item pane columns - fixed.
· Preview pane scroll arrows scrolled an unintuitive amount. Now scrolls a line at a time.
· Preview pane scrollbars failed to proportionally re-size immediately after changing the font with View|

SetFont - fixed.
· Autosave verbosely fails when the datafiles are in use, for example, by backup software. Now fails 

quietly.
· Allowed an out of range value in the options for “Show N clips in the system tray”. Now repeatedly 

prompts until a number within range is entered.

2.00
ClipCache is no longer freeware, and is now shareware.

Features:
· Added options:

· The window Close (‘X’) button terminates ClipCache.
· Hide window after drag-drop to app from ClipCache.
· Compact on startup.
· Always show ClipCache in the Windows task bar.
· Capture enhanced metafiles.
· Move an item to the top of the list on copying to clipboard.

· Added Edit|Find Clips and Edit|FindNext commands.
· Complete re-write of fundamental operations.
· OLE is used (instead of Win32 Clipboard API) for Clipboard handling.
· Improved drag-drop support:

· All supported formats can be dragged from ClipCache.
· All supported formats can be dragged to ClipCache (either Group or Item pane)

· Clipboard format Enhanced Metafile is now supported.
· Added a white outline on the active group arrow (for users with dark background colours.)
· Added a command to clear the current contents of the clipboard (Edit|EmptyClipboard.)
· Added a new menu “Text” with formatting operations:

· Trim left
· Trim right
· Remove empty lines
· Remove linebreaks
· Remove CR/LFs
· Upper case
· Lower case

· Editor window font now uses same font as the preview window.
· Added more commands to the item pane right click menu.
· Added a Format menu button to the text editor dialog to allow use of all format operations.
· Append text capture mode works more intuitively.
· Added menu item Help|Register.
· Added tray menu items, Purge All Groups and Empty Clipboard.
· A compaction info dialog is displayed prior to using File|Compact.
· Duplicates are handled better, they are no longer captured.
· When deleting an item, its hotkey is now unassigned automatically. 
· Added ability to save any clip as an individual files in its specific format.
· When saving a clip, the save dialog offers the clip name as the filename.
· Clip naming ignores CR/LF and Tab characters providing a neater display.
· Hourglass is displayed when populating a group.
· Flat-look toolbar.



· Minor GUI improvements.

Fixes:
· Fixed a bug that caused specific versions of MSWord to crash.
· Fixed a bug that incorrectly positioned the main window if task bar was top/left of the desktop.
· Preview window uses correct system colour for displaying text. 

1.41

Fixes:
· Fixed a resource problem under Windows95

1.40

Features:
· Item sorting, sort by Name, Size, Format, Date (default.)
· Advanced merge allows ordering and insertion of new line between clips.
· Text append capture mode (with ‘append mode’ tray icon.)
· Edit existing text clips.
· Create new (empty) text clips.
· Added ‘Edit’ to the right click menu of the item pane (text clips only.)
· Added a ‘Compact’ command to the file menu.
· Accelerator for ‘Delete’ is now just the delete key and not Shift+Delete
· Help menu now has a Web submenu.
· Minor user interface modifications.

Fixes:
· Fixed a bug didn’t allow bitmaps to be put onto the clipboard from the system tray menu.

1.30

Features:
· Added support for Bitmaps (Device Independent Bitmaps)
· Registered filetype icons are now used for clips item icons
· Trash deletion and compaction operations are now much quicker
· Added an option to not capture bitmaps larger than N bytes
· Added an option to allow autosaving of the database every N minutes
· Hide application is now available    on the File menu (accelerator Escape)
· Switch panes is now available on the View menu (accelerator Tab)
· Save is now available on the File menu, which allows manual saving of the current database
· Re-arranged the options startup dialog more logically
· Increased quick select tooltip display time
· Hotkey box for items is now larger, so longer hotkey combinations can be viewed
· Tray Icon now only requires one click to display the main window

Fixes:
· Fixed a bug that displayed an underline character in item/group property sheets when the item/group 

names included an ampersand
· When using quick select hotkeys, the first and last items are now correctly displayed as a tooltip
· Minor bug fixes



1.20

Features:
· Hotkeys may be assigned to clip items via the Item Properties
· The font used to display text clips is now configurable
· Filtering of items that have been assigned hotkeys
· Force a display refresh
· Item Properties now contains the window title from which the clip was copied
· Group name is displayed in the QuickSelect tool tip
· Increased the maximum number of item displayed on the system tray
· Tidied up dialogs (ie: use of commas within large numbers etc.)

Fixes:
· Fixed a bug that caused a crash at startup if 'AutoLoad Recent' was enabled and the file didn't exist
· Fixed a bug that caused ClipCache to consume more memory than required
· Fixed a bug that corrupted clips if an item was deleted and moved from Trash to another group
· Removed the ability to select multiple groups

1.00

Initial Release



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



How to . . .
Capture a window image
Maintain the size of each group
Maintain the size of the database
Organise items
Rename items
Make use of Quick Select
Switch between Group and Item pane
Hide the main window
Exit clipcache
Retrieve frequently used clips



Capture a window image

Make the window you want to capture active. Press Alt+PrintScreen key on the keyboard. 
The print screen key is usually marked as ‘PrtSc.’

To capture the whole screen, just press PrintScreen.



Renaming Groups and Items

Select the group or the item, then choose Tools | Rename.



Switching Panes

Press the Tab (or Shift+Tab) key to switch between panes.



Hiding The Main Window

· To hide the main window when ClipCache starts, see the startup options.
· To hide the main window without copying anything to the clipboard, press the ESCAPE.
· To automatically hide the main window after putting an item onto the clipboard, see the 

window options.



Terminating ClipCache

The usual close window button does not exit ClipCache. It minimises the window to the 
system tray. To exit ClipCache choose File | Exit.



Organising Items

· To structure and organise your items into groups, select the items you wish to move, 
then drag then to the desired group.

· If you are going to be copying objects with a specific topic (ie: research notes from 
various web pages) to the clipboard, it would be best to make a new group and make it 
the active group.



Maintain Group Size

Enable the group size limits in purge properties for each group. 

and

Enable ‘Purge all groups after opening a ClipCache file’ in options startup page.



Maintain Database size

Follow the procedure for maintaining group size.

and

Regularly clear trash with Tools | Clear Trash. Tip: Enable ‘Clear trash after opening a 
ClipCache file’ in options startup page to automate trash clearing.



Using Quick Select

If you wish to copy and paste several pieces of data from say, a text file, to say, various 
fields in a database form, simply copy all the items from the text file then switch to the 
database form. Use the ‘Quick select’ hotkeys to put the next (or previous) item onto the 
clipboard. There is no need to keep switching between the text-editor and database form.

Quick selected up:
This system wide hotkey places the item just above the currently selected item, onto the 
clipboard. The main window does not need to be open. A tool-tip will appear just below the 
mouse pointer showing the name of currently selected item.

Quick select down:
This system wide hotkey places the item just below the currently selected item, onto the 
clipboard. The main window does not need to be open. A tool-tip will appear just below the 
mouse pointer showing the name of currently selected item.

To assign the hotkeys see hotkey options.



Retrieve frequently used clips

Right click on a clipped item and select properties.    Click on the “Shortcut key” box and 
press the desired hotkey combination. Use the same keypress to place the item onto the 
clipboard at any time. 







New Database (File menu)
Use this command to create a new database.

You can open an existing database with the Open Database command.



Open Database (File menu)
Use this command to open an existing database. You can create new documents with the New Database 
command

Shortcuts
Keys: CTRL+O



Save Database (File menu)
Use this command to save any changes you have made. This is automatically done when you exit 
ClipCache or when you choose to open a different database file.

Saving can be done automatically in the advanced options dialog.



Save Database As (File menu)
Use this command to save the currently open database with a different filename. ClipCache displays 

the Save As dialog box so you can name your database. The new database will become the 
currently open database, this means:

§ Any changes to the database will be made only to the new database.
§ The new database will be opened then next time ClipCache starts (if autoload is enabled.)

To save a database with its existing name and directory use the Save Database command.

To save a database as a copy use the Archive Database As command 



Archive Database As (File menu)
Saves a copy of the database. ClipCache displays a dialog box so you can provide a name for the copy.

This command is useful for backing up your database.

To save a database with its existing name and directory use the Save Database command.



Compact Database (File menu)
Reduces the size of the database by removing “holes” in the data file. This is known as compaction. Do 
not confuse this command with compression.

This can be done automatically at startup.

Tech-Note: when items are permanently deleted (from the Trash group), the data for the clip is not 
removed from the data file immediately. Instead, it is made invisible. This is because deleting data from 
the data file involves re-calculation of many clip items and may take some time. This command gives you 
the manual ability to compact the data file.



Mail Clip (File Menu)
Sends the currently selected clip via email. Images are converted to files and sent as attachments.

Note: To use this feature you must have installed and correctly configured MAPI on your system.



Save Clip (File menu)
Saves the currently selected clip to a file. The format of the file is dependent on the format on the clip. For
example, choosing ‘Save Clip…’ with a text clip selected will save the clip as a text file.



Page Setup
Use this command to set page margins for printing.



Print
Use this command to print a clip.

Shortcuts
Keys: CTRL+P



1, 2, 3, 4 (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Hide (File menu)
Hides the main application window.

Shortcuts
Keys: Escape



Exit (File menu)
Use this command to end your ClipCache session. 



Cut (Edit menu)
Copies the selected clips to the clipboard and then (permanently) deletes the selected clips. This 
command is unavailable if there are no clips selected.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy (Edit menu)
Copies the selected clips to the clipboard. This command is unavailable if there are no clips selected.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste (Edit menu)
Use this command to insert the clipboard contents into the currently selected group. This command is 
unavailable if the clipboard is empty.

Shortcuts
Toolbar:

Keys: CTRL+V



QuickPaste (Edit menu)
QuickPaste pastes the selected clip(s) into most recently used application.

Shortcuts
Toolbar:



FormPaste (Edit menu)
QuickPaste pastes the selected clip(s) into most recently used application, and then advances to the next 
field of that application – as if you had pressed Tab.

Shortcuts
Toolbar:



Enable AutoPaste (Edit | AutoPaste menu)
Use this command to enabled AutoPaste.



Set New Target (Edit | AutoPaste menu)
This command changes the AutoPaste target to the current QuickPaste target. To change the AutoPaste 
target, bring to the front the desired target app, then open ClipCache and choose this command.



Target Keeps Focus (Edit | AutoPaste menu)
When AutoPasting, input focus is temporarily switched to the AutoPaste target, and returns back to the 
window you are working in. Enabling this command will result in keeping input focus with the target 
window after AutoPasting.

This allows you to capture text, make any edits, and then you can manually return back to the application 
you were working in.



Empty Clipboard (Edit menu)
The current content of the Windows clipboard is deleted. If you have previously copied a large object to 
the clipboard that you no longer require, use this to free up memory.



Select All (Edit menu)
Use this command to select all the clips in the item pane.



Invert Selection (Edit menu)
Use this command to invert the selection of clips in the item pane.



Find (Edit menu)
Use this command to specify the search criteria used to search for clips. The search is performed in the 
specified direction. All groups can be searched by checking Look in all groups. The Advanced button 
allows the source window and source URL fields to be specified in the search. All non-empty fields in the 
dialog box must be matched to satisfy the search.

If you have entered text in the Containing field you can click Edit|FindNextInClip (F4) to find the next 
occurrence of the text in the previewed clip.

Shortcuts
Keys: Ctrl+F



Find Next (Edit menu)
Find the next occurrence of a clip that matches the search criteria specified in the Find Clip dialog. 

Shortcuts
Keys: F3



Find Next In Clip (Edit menu)
Finds the next occurrence of the text specified in the Containing field of the Find dialog.

Shortcuts
Keys: F4



Find Replace Text (Edit menu)
Use this command to display a dialog box for searching and replacing text within the previewed clip.

Shortcuts
Keys: Ctrl+R



Toolbar (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in ClipCache, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.



Clip Shortcut Keys (View menu)
Use this command to view clipped items that have been previously assigned a shortcut key.
 
To assign a shortcut key to a clip: Right-click the clip in ClipCache’s main window, and click “Properties” 
The properties dialog will appear and allows you to add, modify or delete the shortcut key.

Shortcuts

Toolbar:
Keys: Ctrl+K



Status Bar (View menu)
Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button. A check mark appears next to the menu item when the 
Status Bar is displayed.



Large Icons (View menu)
Use this command to display the items in the item pane as large icons.



Small Icons (View menu)
Use this command to display the items in the item pane as small icons.



List (View menu)
Use this command to display the items in the item pane as a list.



Details (View menu)
Use this command to display the items in the item pane in detail (report).



Sort Ascending (View menu)
Sorts the clips in the item pane in ascending order. 



Sort by Name (View menu)
Sorts the clips in the item pane by Name. 



Sort by Size (View menu)
Sorts the clips in the item pane by Size.



Sort by Format (View menu)
Sorts the clips in the item pane by Format.



Sort by Date (View menu)
Sorts the clips in the item pane by Date.



Sort by Source (View menu)
Sorts the clips in the item pane by Source.



Sort by Position (View menu)
Sorts the clips in the item pane by Position. This allows the order of the clips to be arranged by dragging 
and dropping selected clips to a new location.



Refresh (View menu)
Use this command to refresh all the panes (group, item and preview.)

Shortcuts
Keys: F5



Maximize Preview Pane (View menu)
Use this command to toggle the preview pane size between normal and maximized.

Shortcuts
Keys: F11



Always on Top    (View menu)
Forces ClipCache’s main window to be the top most window.

Shortcuts
Keys: Ctrl+T



Keep Window Open (View menu)
Use this command to temporarily keep ClipCache’s main window open. A scenario where this would be 
useful is when you normally have the “minimize” options configured, so that ClipCache will minimize when
either:

You copy a clip in ClipCache
You switch away from ClipCache to another program
You drag-dropping from ClipCache to another program

If you wanted to copy two or more clips, you would have to reopen ClipCaches main window for each clip 
– because it would automatically minimize. However, clicking “Keep Window Open” will temporarily ignore
minimization options. Clicking for a second time will revert back to normal operation.

Note: even when “Keep Window Open” is enabled, you can always explicitly minimize the window, for 
example: by clicking the minimize button in the main window title bar. Only automatic minimization as 
outlined above is affected.

Shortcuts
Keys: Ctrl+W



Create Text Clip (Text menu)
Creates a new and empty text clip ready for editing. This may be used to easily add text clips without the 
need to open a text editor.
 
Shortcuts

Toolbar:
Keys: CTRL+N



Edit Text Clip (Text menu)
Allows the editing of existing text clips.
 
Shortcuts

Toolbar:
Keys: CTRL+E



Merge Text Clips (Text menu)
Use this command to merge together several text clips into one single text clip. You will be shown a dialog
box with a list of selected clips. Use the ‘up’ and ‘down’ buttons to order the clips accordingly.

Shortcuts
Keys: CTRL+M



Append Text Captures (Text menu)
When ClipCache is in append text capture mode, when you next copy text to the clipboard, ClipCache will
append the text to the currently selected text clip. The contents of this new clip will then be placed onto 
the clipboard. This will give the effect of actually appending text to the clipboard.

Note: Because this mode causes ClipCache to work differently when capturing text, the system tray icon 
is modified to alert you of this.



Clip to Plain Text (Text menu)
Converts the clip to plain text, stripping out any Rich Text formatting attributes such as font face and size. 
This will also reduce the size of the clip.



MIME %nn Codes to ASCII (Text menu)
Converts MIME encoding (%hex) to its ASCII equivalent. MIME encoding is sometimes used in emails or 
URLs.

Before:

ClipCache%20Plus

After:

ClipCache Plus



MIME =nn Codes to ASCII (Text menu)
Converts MIME encoding (=hex) to its ASCII equivalent. MIME encoding is sometimes used in emails or 
URLs.

Before:

ClipCache=20Plus

After:

ClipCache Plus



Trim Bracket ‘>’ Indentation (Text menu)
Trims leading ‘>’ characters on each line.

Before:
>
>>john said:
>>>this text has been heavily quoted by
>>>many email programs.

After:

john said:
this text has been heavily quoted by
many email programs.



Trim Pipe ‘|’ Indentation (Text menu)
Trims leading ‘|’ characters on each line.

Before:
|
||john said:
||||his text has been heavily quoted by
|||many email programs.

After:

john said:
this text has been heavily quoted by
many email programs.



Trim Colon    ‘:’ Indentation (Text menu)
Trims leading ‘:’ characters on each line.

Before:
:
::john said:
::::his text has been heavily quoted by
:::many email programs.

After:

john said:
this text has been heavily quoted by
many email programs.



Trim Space Indentation (Text menu)
Trims leading spaces on each line.

Before:
            line1
                    line2
          line3

After:
line1
line2
line3



Trim Tab Indentation (Text menu)
Trims leading tabs on each line.

Before:
line1
line2
line3

After:
line1
line2
line3



Trim Left (Text menu)
This command deletes all leading spaces and tabs from each line. Some web browsers indent text in this 
way, so this command has been assign a shortcut key.

Before:
Hello World
          Testing 1 2 3
          Testing 4 5 6

After:
Hello World
Testing 1 2 3
Testing 4 5 6

Shortcuts
Keys: CTRL+L



Trim Right (Text menu)
This command deletes all trailing spaces and tabs from each line.



Remove Empty Lines (Text menu)
This command removes all lines that contain non-text characters (I.E. tab, space etc.)

Before:
Clip

Cache

After:
Clip
Cache



Remove Linebreaks (Text menu)
This command is much like the ‘Remove CR/LF’ command except that a space is inserted in-between 
lines that have been joined. This leaves the text readable because words are properly spaced at the join.
 
Before:
This is line one
and this is line two.

This is the next paragraph.

After:
This is line one and this is line two.

This is the next paragraph.



Remove CR/LFs (Text menu)
Removes all carriage return and linefeed characters so that the text becomes one long line. Notice where 
the lines are joined, we get the undesired (in this example) results “…oneand…” In this case it would be 
better to use Remove Linebreaks.

Before:
This is line one
and this is line two.

After:
This is line oneand this is line two.



Paragraph Spacing (Text menu)
Adds 1 empty line between paragraphs. If there is more than 1 empty line already in the text, then empty 
lines are removed so that only 1 empty line remains.
 



Upper (Text menu)
Converts all the characters to upper case.

Before:
ClipCache

After:
CLIPCACHE



Lower (Text menu)
Converts all the characters to lower case.

Before:
ClipCache

After:
clipcache



Transpose (Text menu)
Toggles the case of each character. Upper becomes lower case and lower becomes upper case.
 
Before:
ClipCache

After:
cLIPcACHE



Sentence (Text menu)
Capitalizes the first character of a sentence. The remaining characters within the sentence are not forced 
to lower case.
 
Before:
one. two. this is a FAQ.

After:
One. Two. This is a FAQ.



Sentence Strict (Text menu)
Capitalizes the first character of a sentence. The remaining characters within the sentence are forced to 
lower case.
 
Before:
one. two. Sentence STRICT.

After:
One. Two. Sentence strict.



Word (Text menu)
Capitalizes the first character of a word. The remaining characters within the word are not forced to lower 
case.
 
Before:
Capitalizes the first character of a word.
 
After:
Capitalizes The First Character Of A Word.



Word Strict (Text menu)
Capitalizes the first character of a word. The remaining characters within the word are forced to lower 
case.
 
Before:
Capitalize the first character of a word STRICT.
 
After:
Capitalize The First Character Of A Word Strict.



Strip <> From Email Addresses
Strip < > from email addresses in the selected clip..

Caution: An email address is determined by the ‘at’ symbol between angle brackets, for example: 
<xxxx@xxxx>

Before:
<support@xrayz.co.uk>
<anon@anon.com>
<caution@>
noproblem@this.line
 
After:
support@xrayz.co.uk
anon@anon.com
caution@
noproblem@this.line



Strip HTML Tags
Strip ‘HTML tags’ in the selected clip.

Caution: No standard HTML tags are checked against. A tag is simply determined by <anything-between-
brackets>. Nested tags are supported.

Before:
<table width=630 cellpadding=0 cellspacing=0 border=0>
<tr>
    <td bgcolor=#003388 align=center>
    <font color=#aaaaaa><b>
    [ <a href="index.html"><font face="tahoma, arial" size=1 color=#ffffff>HOME</font></a> ]
    <a href="update.html"><font face="tahoma, arial" size=1 color=#ffffff>UPDATE</font></a> |
    <a href="support.html"><font face="tahoma, arial" size=1 color=#ffffff>SUPPORT</font></a> |
    <a href="about.html"><font face="tahoma, arial" size=1 color=#ffffff>ABOUT</font></a> |
    <a href="register.html"><font face="tahoma, arial" size=1 color=#ffffff>REGISTER</font></a>
    </b></font>
    </td>
</tr>
</table>

After:

    
    
    [ HOME ]
    UPDATE |
    SUPPORT |
    ABOUT |
    REGISTER
    
    



Cleanup Text
This command shows the text cleanup dialog box



Cleanup Text Dialog
This dialog allows multiple text formatting operations to be carried out simultaneously. Formatting settings
can be saved as a pre-set, allowing instant access to commonly used settings.

Previously saved settings
The combo box displays a list of all the pre-sets, which you have previously saved. 

Save:
Saves the current format settings using the name in the combo box.
 
Rename:
Renames the pre-set that is displayed in the combo box to something that is more meaningful.

Trim
See the following for a description:
Trim bracket
Trim Pipe
Trim Colon
Trim Space
Trim Tab
Trim custom allows you to pick any character to trim.

Lines
See the following for a description:
Remove empty lines
Remove linebreaks
Remove CR/LFs
Paragraph Spacing

Case
See the following for a description:
Upper
Lower
Transpose
Sentence
Sentence Strict
Word
Word Strict

Strip
See the following for a description:
Strip <> from email addresses
Strip HTML tags

Convert
See the following for a description:
MIME %nn Codes to ASCII
MIME =nn Codes to ASCII

Add as new clip
Adds the modified clip as a new clip, thus allowing a copy of the original to be kept.



Word Wrap (Text menu)
Toggle the word wrap at the preview pane boundary.
 



Set Font (Text menu)
Use this command to change the font used to display text clips in the preview pane.



Properties (Tools menu)
Displays a properties dialog box for either the select group or the selected item(s).

Group: General
Purge

Item: General

Shortcuts

Toolbar:
Keys: ALT+Enter



Delete (Tools menu)
Deletes the selected group or item by moving it into the trash group. Note: deleting items from the trash 
group permanently deletes the item(s).

In versions previous to ClipCache 1.40, Shift had to be pressed at the same time as Delete. This is no 
longer a requirement. In fact, doing so will result in no delete operation.

Shortcuts

Toolbar:
Keys: Delete



Rename (Tools menu)
Renames the selected group or item.

Shortcuts

Toolbar:
Keys: F2



New Group (Tools menu)
Creates a new group in which to store items. You may edit the properties for the group as required.

Shortcuts

Toolbar:
Keys: CTRL+G



Activate Group (Tools menu)
Makes the selected group, the active group.

Shortcuts
Keys: Hit ENTER on the selected group.



Purge Group (Tools menu)
Purges the selected group. The group’s purge properties are taken into consideration. Any items that 
exceed the groups’ settings will be moved to trash.



Purge All Groups (Tools menu)
Purges all groups. Each group’s purge properties are taken into consideration. Any items that exceed the 
groups’ settings will be moved to trash.



Clear Trash (Tools menu)
Permanently delete all items in the trash group.
 
Shortcuts

Toolbar:



Repair Clipboard Chain (Tools menu)
ClipCache is removed from the clipboard viewer and re-inserted at the front of the chain. This command 
should be used when ClipCache is no longer capturing clips because an application has severed the 
clipboard viewer chain. 



Capture Clips (Tools menu)
Enables/disables clipboard captures. The system tray will show a no-entry sign when capturing is 
disabled.

Shortcuts
Keys: Ctrl+Q



Options (Tools menu)
ClipCache’s main options are split into several areas:

· General
· Window
· Hotkey
· Startup
· Advanced



View Plug-ins (Plug-ins menu)
Use this command to manage your plug-ins.



Help Topics (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using ClipCache and various types of reference information.    



What’s This (Help menu)
This command will turn the mouse pointer into a “help pointer”. Use the help pointer to get help on toolbar
buttons and menu items by clicking on them.

To cancel the help pointer press Escape.
 
Shortcuts

Keys: Shift+F1



Tip Of The Day (Help menu)
Shows a tip of the day.



Purchase ClipCache Now (Help menu)
Use this command to purchase ClipCache Plus online using your default web browser.

NOTE: This command is removed when ClipCache has been previously purchased and the license code 
has been successfully entered. 



Web (Help menu)
Launches your default browser with the relevant URL.



Web (Help menu)
Launches your default browser with the relevant URL.



About (Help menu)
Use this command to display the copyright notice and version number of your copy of ClipCache.




